
E-M-HW4v3-F2-018_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3: Device Manager and Data 
Logging HL20 and HL21 data loggers 

Document title 
Page 1 of 14 

 

© 2010; Rotronic AG                                                         E-M-HW4v3-F2-018_10 

 
 
 

HW4 Software version 3 
 

Device Manager and Data Logging 
HL20 and HL21 Data Loggers 

 
 

 
 
 



E-M-HW4v3-F2-018_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3: Device Manager and Data 
Logging HL20 and HL21 data loggers 

Document title 
Page 2 of 14 

 

© 2010; Rotronic AG                                                         E-M-HW4v3-F2-018_10 

Table of contents 
1  ORGANIZATION OF THE HW4 MANUALS....................................................................................... 3 

2  OVERVIEW ......................................................................................................................................... 4 

3  DEVICE MANAGER............................................................................................................................ 4 
3.1  Device Manager Menu Bar ................................................................................................................ 5 
3.2  Device Information............................................................................................................................. 8 
3.3  Settings.............................................................................................................................................. 9 
3.4  Alarm ................................................................................................................................................10 
3.5  Display (optional) ..............................................................................................................................11 

4  DATA LOGGING............................................................................................................................... 12 
4.1  Record Data – Settings.....................................................................................................................12 
4.2  Read Data.........................................................................................................................................13 
4.3  Adding a calculated parameter to the log file ....................................................................................13 

5  DOCUMENT RELEASES ................................................................................................................. 14 
 
 
 
 
 



E-M-HW4v3-F2-018_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3: Device Manager and Data 
Logging HL20 and HL21 data loggers 

Document title 
Page 3 of 14 

 

© 2010; Rotronic AG                                                         E-M-HW4v3-F2-018_10 

1  ORGANIZATION OF THE HW4 MANUALS 
The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list 
of the HW4 manuals is provided in document E-M-HW4v3-DIR 
 
HW4 Manuals Contents 

HW4 Main Book 

General software description 
Installation, start-up and settings 
Device connection methods 
Functions common to all devices used with HW4 

Device Specific Functions 1 
(separate book for each device type or model) 

Legacy devices (original HygroClip technology): 
 
o HygroLog NT data logger 
o HygroFlex 2, HygroFlex 3 and M3 transmitters 
      (same icon in device tree) 
o HygroLab 2 and HygroLab 3 bench indicators 
o HygroPalm 2 and HygroPalm 3 portable indicators 
o HygroClip DI digital interface 
o HygroClip Alarm programmable logic 
o HygroStat MB 
 
Device Manager (device configuration) and other device 
specific functions 

Probe Adjustment 1 Humidity and temperature adjustment function common to 
all legacy devices (original HygroClip technology) 

Device Specific Functions 2 
(separate book for each device type or model) 

Devices based on the AirChip 3000 technology: 
 
o HygroClip 2 (HC2) probes 
o HF3 transmitters and thermo-hygrostats 
o HF4 transmitters 
o HF5 transmitters 
o HF6 transmitters 
o HF7 transmitters 
o HL20 and HL21 data loggers 
o HP21, HP22 and HP23 hand-held indicators 
o Custom designed OEM products 
 
Device Manager (device configuration) and Data Logging 
functions 

Probe Adjustment 2 Humidity and temperature adjustment function common to 
all devices based on the AirChip 3000 technology 

Data Recording Function Data recording function common to all devices based on the 
AirChip 3000 technology 

 
Both the HW4 manuals (software) and device specific manuals (hardware) are available from the HW4 CD. 
The manuals can also be downloaded from several of the ROTRONIC web sites. 
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2  OVERVIEW 
This section of the HW4 manual covers only the following HW4 modules: 
 
HW4 Functional Modules HL20 / HL21 Usage 

o HL20 and HL21 user configurable settings Device Manager 

o HL20 and HL21 Data Logging 
 
o The Probe Adjustment module is used calibrate and adjust the probe humidity and temperature signals. 

This module is common to all probes and instruments based on the AirChip 3000 technology and is 
separately described in the HW4 manual E-M-HW4v3-A2-001 
 

o HW4 functions that are not device dependent are covered in the HW4 manual E-IN-HW4v3-Main. 
 
 
 

 
When HW4 has detected a HL20 or HL21 data logger an 
icon appears in the left pane of the HW4 main screen. 
Click on the + sign to the left of the con to display a list of 
the available functional modules. 
 
 
 
 

3  DEVICE MANAGER 
Device Manager is used to configure the data logger.  

 
 
 
 
To select the Device Manager module, click on it with the 
left mouse button. HW4 opens the Device Manager form. 
 
 
Device Manager automatically interrogates the data 
logger and downloads its current configuration. 
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The different sub-forms that are available within the Device Manager form are listed in a tree located on the 
left pane of the form. To select a sub-form, click on it with the left mouse button. 

3.1   Device Manager Menu Bar 
The Device Manager menu bar is located at the top of the form. 
 
File 
 
The file menu is used to save to the PC, or to retrieve from the PC, the configuration settings of the data 
logger. The settings are saved in an XML file with the extension DAT. Saving the configuration settings to a 
file is useful for several reasons: 
 

- provides a backup when the device configuration has been changed in error 
- provides a means of quickly configuring a replacement device in the exact same manner as the 

original device 
- provides a means of quickly configuring a number of identical devices  

 
● Open: opens the device configuration folder specified in HW4 Global Settings - File Locations Tab - 

and displays all available probe and device configuration files (extension DAT). Select the appropriate 
file and click on Open in the explorer form. The contents of the configuration file are loaded to the 
Device Manager form. Review the contents of the Device Manager sub-forms. Click on the Device 
Manager OK button to write the configuration settings to the device or click on the Cancel button to 
leave the device unchanged. 
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● Save As: saves the current configuration to an XML file with the extension DAT) in the device 

configuration folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory 
and any file type may be specified. 

 

 
 
 
● Exit: exits Device Manager 
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Tools 
 

● Firmware Update: This tool is used to update the firmware of the data logger after downloading a new 
firmware file from the ROTRONIC website to your PC. Firmware files are given a name that shows both 
to which device the file applies and the version number of the firmware. All firmware files have the 
extension HEX. The ROTRONIC website will publish firmware updates as required. 
 
The tool opens a form that allows you to specify the folder where the firmware update file is located and 
to select the file. Click on OPEN to start the update process. 
  

 
 

IMPORTANT: the data logger must be powered during the entire process. Loss of power when the probe is 
being updated may have unexpected results and prevent future operation of the data logger.  

 
● Generate Protocol: generates a Device Configuration Protocol. This text file is automatically saved in 

the folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file 
type may be specified. This action is not recorded in the User Event file.  

 
 

Help: 
 
● HW4 Help: Opens HW4 Help 
● About HW4: Displays the version number and ID number of HW4 



E-M-HW4v3-F2-018_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3: Device Manager and Data 
Logging HL20 and HL21 data loggers 

Document title 
Page 8 of 14 

 

© 2010; Rotronic AG                                                         E-M-HW4v3-F2-018_10 

3.2   Device Information 
 

 
 

 
● Device Protection: This function is used to prevent unauthorized access to critical functions such as 

configuration changes, humidity and temperature adjustment, etc. Click on the underlined link next to 
Device Protection. HW4 opens the following form where a password can be entered (maximum 8 
characters): 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
Click on the Device Manager OK button to write the new protection settings to the data logger. 
 
FORGOT THE PASSWORD? – Remove the batteries from the data logger and disconnect the data 
logger from the PC. After re-connecting the data logger to the PC, you have about one minute to use 
the default password !resume! (include the exclamation marks). After one minute the default password 
is no longer accepted. 
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3.3   Settings 
 

 
 

● Device Name: As far as possible use a unique device name (maximum 12 characters) 
 
● Humidity: enter here the letters to be used after the “%” symbol used for relative humidity 
 
● Temperature: Left click on the arrow to the right of the text box and select the temperature engineering 

unit (˚C or ˚F). 
 

● Calculation: Left click on the arrow to the right of the text box and select from the following: No 
calculation, Dew Point or Frost Point 
 

● System Time (real time clock): click on the blue link labeled “Refresh” to set the data logger internal 
real time clock to the date and time of the PC. 
 

● Limit humidity to 100%: typically, the humidity sensor gives a reading slightly above 100 %RH when 
condensation occurs at the surface of the sensor. Check this box to limit the maximum value of humidity 
to 100 %RH. 
 

● Generate Humidity Fixed Value / Generate Temperature Fixed Value: place a check mark in these 
boxes to make the data logger generate fixed humidity and temperature values instead of the actual 
measurements. This function can be used to validate the recording of data by the logger. 
 
The fixed values must be with the following limits: -999.99 and 9999.99 
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Whenever the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main 
screen (current Values tab) as shown below. The fixed value is shown in red when the probe is not selected. 
 

 
 

3.4   Alarm 
 

 
 
Note: This function applies both to the data logger display (an alarm symbol appears) and to the data logger 
digital communication with a PC via service connector. 
 
Alarm conditions can be defined for humidity, temperature and the calculated parameter. Values that are 
below the low alarm value or above the high alarm value will trigger an alarm. The value specified for the 
alarm function hysteresis is used for both the low and the high alarm. 
 
All versions of HW4 will show an out-of-limits value alarm in red on the monitor screen. In addition, HW4 
Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm table and 
generate a report whenever an out-of-limits condition occurs. 
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3.5   Display (optional) 
 

 
 

• 2 Decimals: check this box to have the display show the values with 2 decimals instead of one 
decimal 
 

• Display: click on the arrow to the right of the box and select Humidity / Temperature or Calculation / 
Temperature 
 

• Backlight Operation: click on the arrow to the right of the box and select from Always off or Always 
on. In the “Always on” mode, the backlight is turned on when the function key is used and is 
automatically turned off after a few seconds. 
 

• De-energize after: this setting is used to enable or disable the display sleep function. Click on the 
arrow to the right of the box and select from Never (the display can still be turned off manually with the 
function key), After 1 minute, After 5 minutes, After 10 minutes or After 20 minutes (the display is 
automatically turned off). Turning off the display as soon as practically possible is essential to 
conserve battery power. 

 
• Contrast: use the slider to adjust the contrast of the local LC display and click on the “Update” link to 

change the contrast. Click on the Device Manager OK button to write the new contrast setting to the 
data logger  
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4  DATA LOGGING 
Data Logging is used to configure the data logging function, to start and stop data logging and to download 
the recorded data to the HW4 PC. 

 
 
To select Data Recording, click on it with the left mouse 
button. HW4 opens the Data Recording form. 
 
 
 
 
 
 
 
 
 

4.1   Record Data – Settings 
 

 
 
This form is used to select the following: 
 

o Recording mode:  
 
- Start-Stop: ends the recording when the memory is full 
- Loop: when the memory is full, keep recording and dump the oldest data record 
 

o Log interval: 5 seconds to 1 hour, in 5 seconds increments 
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Note: starting or stopping data recording with HW4 automatically sets the data logger real time clock to the 
PC date and time.  
 

4.2   Read Data 
This form is used to download to the PC the data present in the data logger memory. The file can be 
downloaded even when data is still being recorded. 
 
Notes: 
 
o The file format (text file - .txt or binary - .log) used by HW4 when saving the data to disk can be 

configured  from the menu bar of the Data Logging form: Settings and Tools > Log File Format 
 
o HW4 can print a protocol of the Data Logging settings:  Settings and Tools > Generate Protocol 
 
 

 
 
 
Click on the blue link labeled “Start Download” to download and view the recorded data. 
 

4.3   Adding a calculated parameter to the log file 
HW4 View Data can be used to add a calculated parameter such as dew point to a log file comprised of 
relative humidity and temperature records. The parameter is calculated for each data record based on the 
relative humidity and temperature values. 
 
HW4 View Data can also be used to replace the calculated parameter in a log file with a different one. 
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HW4 View Data opens automatically after reading data from the HL20 or HL21 data logger. Files that have 
already been downloaded can be opened from the HW4 main menu bar by selecting File > Open. 
To access the “Add / Change calculated parameter” function, click on Tools in the HW4 View Data menu 
bar and select “Add / Change calculated parameter”.  This opens the following form: 

 
 
 
Use the form shown on the left to select one of 
the available calculated parameters. 
 
NOTE: some parameters such as Enthalpy, 
Mixing Ratio etc. require barometric pressure as 
a calculation input. Be sure to enter the correct 
pressure value in the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the OK button to add the selected calculated parameter or change the existing calculated 
parameter. 
 

5  DOCUMENT RELEASES 
 
Release Software Ver. Date Notes 

_10 3.0.0 Jun. 18, 2010 Original release 
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